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 ) Building basic formulas(  هیپا يهاساخت فرمول: 1فصل 

 :  توانست دیفصل، شما خواه  نیا در

 

 ها در اکسل (ساخت فرمول ياه یپا  اصولLearn the basics of building formulas in Excel دیر یبگ ادی) را  . 
 عملگرها ( تی اولوUnderstand operator precedenceدی فرمول خود را درك کن ج ی آن بر نتا ری) و نحوه تأث   . 
 کار ( تیمحاسبات ش کنترلLearn how to control worksheet calculations دیریبگ ادی) را   . 
 ها (فرمول یی جاجابه و   یکپ یچگونگLearn how to copy and move formulas دیریبگ ادی) را   . 
 دامنه ( يهابا نام کارLearn how to work with range names in formulas دیریبگ ادی) را   . 
 است   گرید يهاکار و دفترچه يهات یها در شدامنه ایها به سلول  نکیکه شامل ل ییهافرمول  ساخت

)Build formulas that contain links to cells or ranges in other worksheets and workbooks ادی) را  
 . دیریبگ

.  د یکن  فیمختلف تعر  يهاي ورود   انیم  ياکه رابطه   یاز اعداد و متن است تا زمان  جانیب  ياتنها مجموعه   صفحه اکسل   کی
فصل شما را   ن ی. اکنند ی م  د یتول  یج یو نتا  دهند ی که محاسبات انجام م  د یدهی انجام م  ییهافرمول  جادی کار را با ا  نیشما ا
درك موضوع    ؛ یو متن  یساده حساب  يهااز جمله ساخت فرمول   کند،ی م  ییهنماها رافرمول   هیاز اصول پا  ی برخ  قیاز طر

ها با کردن فرمول   ترخواندن تر ساختن و قابل  کار؛ و آسان   تیش   يهافرمول   ییجاجابه و    یعملگر؛ کپ   ت یمهم اولو  اریبس
  دامنه.  يهااستفاده از نام 

  )Understanding formula basicsها (فرمول  هیدرك اصول پا

  ای: سود شرکت چقدر است؟ آشوند ی م  جاد یخاص ا  سؤالات ارائه پاسخ به    ي ) براworksheetsاکسل (  يهاصفحه   ترشیب
 امسالچه مقدار خواهد بود؟    يگذاره یسرما  کی  ندهیکمتر از بودجه هستند و به چه اندازه؟ ارزش آ  ای  شتریب  هانه یهز

با استفاده    گرید   سؤالاتاز    یانیپای تعداد ب  ن یو همچن  سؤالات  نیبه ا  د یتوانی کارمند چقدر خواهد بود؟ شما م کیپاداش  
 .د ی) پاسخ دهExcel formulasاکسل ( يهااز فرمول 

)  operandsچند عملوند (  ای  کی(=) که سپس به    ي علامت مساو  ک یدارند:    یکسانی  ی اکسل ساختار کل  يهافرمول   تمام
چند عملگر   ای  کی  با  که  -د  توابع باش   يهانام  ایدامنه    يهاها، نامدامنه   ،یارجاعات سلول  ر،یمقاد  تواند ی م  که  -د  رس ی م
)operatorsمانند علامت پلاس (+) و علامت    کنند،ی م  ب یعملوندها را ترک  ینوعبه هستند که    نمادهایی   که  - د  ان) جدا شده

  ). >از (  تربزرگ 
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  )Formula limits in Excel 365( 365فرمول در اکسل  يهات یمحدود

 کند،ی م  نیی) تعworksheet modelsصفحه اکسل (  يهاها و مدل مختلف فرمول   يهاکه اکسل بر جنبه   يشناخت حدود
فرمول که در اکسل    يهات ی. محدودد یمواجه شو  هات یمحدود  نیاست شما هرگز با ا  د یاست، هرچند که بع  یخوب  دةیا

کم از اکسل   احتمالبه   کهی درصورت  ،نی؛ بنابرااند مانده ی باقهمانند گذشته    ز ین  365در اکسل    اند،افته یگسترش    2007
 .دهد ی روز شده را به شما نشان م به  يهات یمحدود 1-1جدول  د،یروی م  365به اکسل  یقبل يهانسخه  ای 2003

 )  TABLE 1-1 Formula-related limits in Excel 365( 365مرتبط با فرمول در اکسل   يهات یمحدود: 1- 1 جدول

  
  


( :نکته     ࢘ࢗ࢖࢕࢔ فاصله  کهی درصورت)  Excelاکسل  از  (شما  بspacesها  عملوندها  نی)  و    عملگرها 
 )operators and operandsروش خوب   کی واقعاً    نیندارد. ا  یاعتراض  د، یخود استفاده کن  يها) در فرمول

 ي تر برا آسان   ار یها را بسآن  تواندی روش م  ن یفرمول به ا   ک یعناصر    جداکردن  رای است؛ زانجام کار    يبرا
همچن  کند.  باش  نیخواندن  داشته  ا  دیتوجه  از  اکسل  (  جادیکه  خط  فرمول line breaksشکست  در  ها ) 

شما امکان به    رایاست؛ ز   دیمف  د، یداشته باش  يبلند  اریفرمول بس   کهی درصورت   یژگیو  نی. اکندی م  یبانیپشت
شکست   کی   جادیا   ي خط ظاهر شود. برا  ن یند که در چ  دی ده  شینما   ياگونهبه و    "شکسته"فرمول را    دهدیم

  . دیرا فشار ده Alt+Enter يدهایفرمول، کل کیخط در 
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  گری) اشاره دارد که درون عبارات دexpressions) به تعداد عبارات (Formula nesting levelsفرمول (  ي سطوح تو در تو
) پرانتزها  از  استفاده  ترتشده  تودرتو )  parenthesesبا  بخش «کنترل  به   Controlling the order of(  ت»ی اولو   ب یاند؛ 

precedenceد یمراجعه کن ،فصل آمده است نی ) که در ادامه ا.  

 ) Entering and editing formulasها (فرمول شیرایو و واردکردن

 :رسد یساده م  يند یفرا) به نظر  worksheetصفحه اکسل ( ک یبه  د یفرمول جد   کی واردکردن 

  . د یانتخاب کن د یفرمول را در آن وارد کن د یخواهی را که م  یسلول .1
 .د یفرمول هست ک ی واردکردنکه در حال   د ییتا به اکسل بگو  د یکن پ ی(=) تا ي علامت مساو کی. .2
  . د یکن پ یفرمول را تا يعملوندها و عملگرها .3
 .   د یرا فشار ده Enter د یفرمول، کل د ییتأ  يبرا .4

و اقدامات ماوس را    برانیم  يدهای از کل  ی چگونه برخ  کند ی م  ن ییمختلف دارد که تع  ي، اکسل سه حالت ورود حالنیباا
 کند:   ریتفس

مساو  یوقت   ):Enter mode(  واردکردن  حالت  علامت  برا   يشما  تا  يرا  فرمول  حالت   د،یکنی م  پیشروع  به  اکسل 
 .   د یفرمول) را وارد کن يمتن (مانند عملوندها و عملگرها د یتوانی حالت م  ن یکه در ا رود ی م واردکردن 

دار) را  جهت د یهر کل ای Page Up ،Page Down(مانند  د یکلصفحه  يناوبر د یاگر هر کل ):Point modeانتخاب ( حالت
  ي حالت برا  نی. اشودی اکسل وارد حالت انتخاب م  د،یدر صفحه اکسل را انتخاب کن  يگریاگر هر سلول د  ای  د،یفشار ده
از هر    د یتوانی م  د،یکه در حالت انتخاب هست  ی . زمانشودی م  ستفاده عملوند فرمول ا  عنوانبه دامنه    ایسلول    کیانتخاب  

 ایر  عملگ   کیشما    نکهیا  محضبه که اکسل    د ی. توجه داشته باش د یاستاندارد انتخاب دامنه استفاده کن  يهاک یاز تکن  کی
 .   گرددیباز م  واردکردن به حالت  د،یکن   پیرا تا يگر یهر کاراکتر د

 د یتوانی حالت م ن یکه در ا شودی م  ش یرایاکسل وارد حالت و د،ی را فشار ده F2 د یاگر کل ):Edit mode( ش یرای و  حالت
جهت چپ و راست   يدهایاز کل  د یتوانی م  د،یهست  شیرایدر حالت و  ی، وقتمثالعنوانبه .  د ی کن  جاد یدر فرمول ا  ی راتییتغ
با   د یتوانی م  نی. همچن د یکاراکترها استفاده کن  واردکردن   ایحذف    ي از فرمول برا  ي گریبه بخش د  نشانگر  ییجاجابه   يبرا

  .د یرا فشار ده F2 د ی، کلواردکردنبازگشت به حالت    ي. براد یبرو ش یرایاز داخل فرمول به حالت و ياانتخاب هر نقطه 

  

  

  ی که اکسل در چه حالت   دیپنجره اکسل بفهم  نییدر پا   تیبه نوار وضع   کردننگاه با    دیتوان ی م :نکته  ࢘ࢗ࢖࢕࢔

  کرد.  دیرا مشاهده خواه Edit ای Enter ،Pointمانند  یقرار دارد. در سمت چپ، عبارات
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  ي برا  راهسه . اکسل  د یکن  جاد یا  یراتییو تغ  د یکه به آن برگرد   د ی داشته باش   از یفرمول، ممکن است ن  ک ی  واردکردن پس از  
 :دهد یفرمول در سلول انتخاب شده به شما م  ک یدر  راتییتغ جادی و ا ش یرایورود به حالت و

 د یکل F2 د یرا فشار ده . 
 د یکن ک یکل دو بار سلول  يرو  بر. 
 نوار فرمول ( ازformula barشودی ها ظاهر معنوان ستون ي بزرگ که درست بالا ی(جعبه متن  د ی) استفاده کن  (

 . د یاز متن فرمول قرار ده يارا در هر نقطه  نشانگرتا 

 ی) و ارجاعtext(  ی )، متن comparison(  سه ی)، مقاarithmetic(   ی: حسابکند ی م   م یها را به چهار گروه تقسفرمول   اکسل
)referenceدر  د یکنی استفاده م  ی متفاوت  يهااز عملگرها است و شما هر گروه را به روش   يامجموعه   ي ). هر گروه دارا .

  . دهمی نحوه استفاده از هر نوع فرمول را به شما نشان م ، يبعد  يهابخش

 ) Using arithmetic formulas( یحساب يهااستفاده از فرمول 

  ی سلول   يهااعداد، آدرس   بیها شامل ترک فرمول   نیها هستند. انوع فرمول  نیترجیرا  یتوجهقابل  به طور  یحساب  يهافرمول 
  يهادر فرمول   مورداستفاده  یاضیر   يعملگرها  2-1. جدول  هستند انجام محاسبات    يبرا  یاضیر  يتوابع با عملگرها  جیو نتا
در    یحساب  يهاتفاده از فرمول را با اس   یتا محاسبات مختلف  دهند ی عملگرها به شما اجازه م  نیا  .کند ی را خلاصه م   یحساب

 . د ی) انجام دهExcelاکسل (

 )The arithmetic operators( یحساب  يعملگرها: 2-1جدول 

  
  نیبه ا  x^yداشته باشد. فرمول =  يشتر یب  ح یبه توض  ازیعملگرها واضح هستند، اما عملگر توان ممکن است ن   ن یا  شتریب

به  ).  9=    3*    3  ی عنی(  کند ی م  د یرا تول   9  جه ی نت  2^3، فرمول = مثالعنوانبه .  رسد ی م   yبه توان    xاست که مقدار    ی معن
 ). 16=  2*   2*  2*   2 یعن یکند (ی م د یرا تول 16عدد   4^2فرمول = ب، یترت نیهم
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 ) Using comparison formulas( ياسهی مقا يهااز فرمول  استفاده 

. اگر  کند ی م   سهیتوابع را مقا  جینتا  ایسلول    يچند عدد، رشته متن، محتوا   ایاست که دو    ی عبارت  ياسه یفرمول مقا  کی
است). اگر عبارت   رصفر یغ(که معادل هر مقدار    شودی داده م   TRUE  ی فرمول به ارزش منطق  جهیعبارت درست باشد، نت

امکان را    نیشما ا  عملگرها به  نی ا(که معادل صفر است).    گرداند ی را برم  FALSE  ینادرست باشد، فرمول ارزش منطق 
 . د ی) انجام دهExcelرا در اکسل ( یمختلف  ساتیکه مقا دهند ی م

 )Table 1-3 Comparison formula operators( ياسه یفرمول مقا يعملگرها: 3-1 جدول

 

فروشنده پاداش پرداخت   ک یبه    ا یکه آ  د یکن  نییتع  د یتوانی ، ممثالعنوان به دارند.    يادیز  يکاربردها  ياسه یمقا  يهافرمول 
ها  . اگر فروش کند ی م سهیمقا  شدهنیی سهم تع  کیرا با   یکه فروش واقع  ياسه یفرمول مقا  کی با استفاده از    ر،یخ  ای  د یکن

 . کند ی م افت یرا در خودپاداش   ندهیاز سهم باشد، نما شتریب

بدهکار   يمشتر   کیکه    ی، اگر مبلغمثالعنوان به .  د یاعتبار را تحت نظارت قرار ده  يآور جمع  ند یفرا  د یتوانی م  نیهمچن
ها مضمون  نی. اد یارسال کن  يآورشاغل جمع  کیرا به    حسابصورتروز گذشته باشد، ممکن است    150از    شتریاست ب
  باشند.  د یمف   ی رت بر عملکرد مالو نظا  هاي ریگم یتصم  تیریدر مد   توانند ی م  ياسه یمقا  يهاکه چگونه فرمول  دهد ی نشان م

 )Using text formulas( یمتن  يهااستفاده از فرمول 

 محاسبات  -  ياسه یمقا  يهاو فرمول   یحساب  هايفرمول   -د  قرار گرفتن  موردبحث  یقبل  يهاکه در بخش   ینوع فرمول  دو
)  text formula(  یفرمول متن  کی  گر، ید  ي سو. از  گردانند ی را برم  ریو مقاد  کنند ی م  جادیا  ییهاسه یمقا  ای  دهند ی انجام م

محصور    ی متن  يهارشته   ، یمتن  يهاکار با سلول   ي برا   &از عملگر    ی تنم  يها. فرمول گرداند یاست که متن را برم   ی فرمول 
 . کنند یاستفاده م  ی توابع متن جی، و نتاقولنقل  يهاشده در علامت 

راه   یکی فرمول   يهااز  از  رشته concatenate(ادغام    ، یمتن   يهااستفاده  فرمول  مثالعنوانبه است.    ی متن  يها)  اگر   ،
="soft"&"ware"    اکسل    د، یسلول وارد کن  ک یرا در"software"  ي هاکه علامت   د ی. توجه داشته باش دهد ی م  شیرا نما  
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متن    يکه حاو   ییهاسلول   بیترک  ي برا  &از    د یتوانی م  نی. همچنشوند ی داده نم  شینما  جهیدر نت   &و عملگر    قولنقل 
فرمول    واردکردن باشد،    "Jerry"  يحاو   A2و سلول    "Ben"متن    ي حاو  A1، اگر سلول  مثالعنوانبه .  د یهستند استفاده کن

=A1&" and "&A2 جهینت  "Ben and Jerry" گرداند ی را برم. 

 ) Using reference formulas( یارجاع يهااز فرمول  استفاده 

  4-1کنند. جدول    جادیمرجع مشترك واحد ا  ک یتا    کنند ی م  ب یها را ترکدامنه   ا ی  ی دو مرجع سلول  یارجاع  يعملگرها
  دهند یامکان را م  نیعملگرها به شما ا  نیا  .کند ی خلاصه م   د،یاستفاده کن  یارجاع  يهادر فرمول   د یتوانی را که م  ییعملگرها

 . د یتر کنها را آسانداده   تیریو مد  د یاکسل استفاده کن  يهاها در فرمول ها و دامنه از سلول  يکه به طور مؤثر 

 

  ) Table 1-4 Reference formula operators( یفرمول ارجاع يعملگرها: 4-1 جدول

  

 ) Understanding operator precedenceعملگرها ( تی اولو بی درك ترت

، در عمل،  حالنیبااعملگر هستند.    ک یکرد که فقط شامل دو مقدار و    د یاستفاده خواه  ياساده   يهااغلب از فرمول   شما
که    یمحاسبات   ب یترت  تر، ده یچیمقدار و عملگر هستند. در عبارات پ  ي شامل تعداد   د یکنی که استفاده م  ییهافرمول   شتریب

. اگر از چپ به راست محاسبه  د یریرا در نظر بگ   2^5+ 3، فرمول = مثالعنوان به . شودی م تیحائز اهم  اریبس شود،ی انجام م
). اما اگر ابتدا عملگر توان را  شودیم   64به توان دو برابر    8است و    8برابر    5+3خواهد بود (  64پاسخ به دست آمده    د،یکن

مثال   ن ی). همانطور که اشودی م  28  بر ابر  25+3است و    25برابر   2^5خواهد بود (  28  جهیو سپس جمع را، نت د یانجام ده
 کند.  د یتول يمتعدد يهاانجام محاسبات، پاسخ بیبسته به ترت تواند یفرمول م   کی دهد،ی نشان م

  ب یترت  نی. اکند ی م  یابیارز  هاتیاز اولو  شدهف یتعر  شیپ  بیترت  کیها را بر اساس  مشکل، اکسل فرمول   ن یکنترل ا  يبرا
محاسبه کند و مشخص کند که کدام قسمت از    یرمبهمیغ  به طورها را  که فرمول   دهد ی امکان را م  نیبه اکسل ا  تیاولو

 . بیترت نی و کدام قسمت دوم و به هم  شودی فرمول ابتدا محاسبه م
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  ) The order of precedence( تیاولو  بیترت 

کامل    بی ترت  5- 1. جدول  شودی م  نیی شدند، تع  یمختلف فرمول که قبلاً بررس   ياکسل بر اساس عملگرها  ت یاولو  بیترت
  یابیاز نحوه ارز  يتا درك بهتر   کند ی جدول به شما کمک م  نیا  .کند ی استفاده شده توسط اکسل را خلاصه م   تیاولو

 .د یها داشته باش در فرمول  اتیعمل بیها در اکسل و ترتفرمول 

 )Table 1-5 Order of precedence in Excelل (در اکس ت یاولو بیترت: 5-1 جدول

  
  ي برا  حی پاسخ صح  ، نی؛ بنابرادهد یکه اکسل عملگر توان را قبل از جمع انجام م   د یمشاهده کن   د یتوانی جدول، م  نیاز ا

  ک ی ي دارا  5- 1از عملگرها در جدول  ی که برخ د یتوجه داشته باش  نیاست. همچن 28که قبلاً ذکر شد،  2^5+3فرمول =
عملگرها   نیکه ا  ستیاست که معمولاً مهم ن  یمعن   نیبه ا  نیم). ایمثال، ضرب و تقس  يمشابه هستند (برا  تیاولو  بیترت

 شوند.   یابیارز ی بیدر چه ترت

*    5خواهد بود (   25جواب به دست آمده    د، ی. اگر ابتدا ضرب را انجام دهد یریرا در نظر بگ   10/2* 5، فرمول = مثالعنوانبه 
  5برابر با  10/  2( د یآی به دست م 25جواب  ن یهمچن د،یرا انجام ده  م یاگر ابتدا تقس). 25برابر با  50/  2و   50برابر با  10
 نیبنابرا  کند،ی م   ی ابیمشابه را از چپ به راست ارز  ت یاولو  بیبا ترت   ییاکسل عملگرها  ، یطور کلبه ).  25برابر با    5*    5و  

 خواهند شد. یابیشما ارز يهافرمول   گونهنیکه ا  د یفرض کن د یشما با
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 ) Controlling the order of precedence( تیاولو   بیترت کنترل

 د یکن  جاد یا  ی فرمول  د یخواهی که م  د ی، فرض کنمثالعنوان به .  د یرا ظرف کن   ت یاولو  بیترت  دیخواهی اوقات، شما م   یگاه
  7شامل    د،یاکرده   يداریدلار خر   10.65  متیرا به ق  يزیکالا را محاسبه کند. اگر شما چ  کی   ات یاز مال  شیپ  نه یکه هز

  د یاستفاده کن  1.07/10.65از فرمول =  د یتوانی م  د، یکن  دایپ  اتیکالا را بدون مال   نه یهز  د یخواهی فروش، و م  ات یدرصد مال
به اضافه    1بر    میتقس  نهیفرمول عبارت است از مجموع هز  ،یطور کل . به دهد ی دلار) را به شما م  9.95(  حیکه پاسخ صح

 .اتینرخ مال

 Totalکل (  نهیهز  ریمتغ  B5. سلول  د یکن  يسازاده یرا پ  یفرمول  نیکه چگونه ممکن است چن  دهد ی نشان م   1-1  شکل

Costرا نما (و سلول    دهد ی م   شیB6  ات ینرخ مال  ر یمتغ  )Tax Rate زهیغر  ن یپارامترها، اول  ن یا  بهباتوجه .  دهد ی ) را نشان م  
 باشد که از فرمول  نیشما ممکن است ا

 = B5/1+B6   

اد یاستفاده کن  یاصل  نه ی محاسبه هز  يبرا نت  شدهداده نشان  E9متن در سلول    عنوانبه فرمول    ن ی.    D9در سلول    جه ی و 
  ن یافتاده است؟ خوب، طبق قوان  یپاسخ نادرست است. چه اتفاق   ن یا  د،یکنی که مشاهده م  طورهماناست.    شدهداده شینما
و سپس   شودی م  می تقس  1ابتدا بر    B5مقدار موجود در    نیبنابرا  دهد،ی م را قبل از جمع انجام    م یاکسل ابتدا تقس  ت،یاولو

 .  شودی اضافه م B6به مقدار 

 نیا  يابتدا انجام شود. برا  B6+ 1که جمع    د یکنترل کن  يرا طور  ت یاولو  بیترت  د یشما با  ح،یپاسخ صح  آوردندستبه   يبرا
کار    نی ا  یاست. وقت  شدهداده شینما  E10طور که در سلول  همان  د،یآن قسمت از فرمول را با پرانتز محاصره کن  د یکار، با

  .د یرس  د ی) خواهD10(سلول  حیانجام شود، شما به پاسخ صح

  

  

  

 
 صورتبه   E10و    E9  يهاها را در سلول ، چگونه من اکسل را متقاعد کردم تا فرمول 1-1در شکل   :نکته  ࢘ࢗ࢖࢕࢔
سلول    کی فرمول    شینما"اکسل استفاده کردم (به بخش    FORMULATEXTدهد؟ من از تابع    شیمتن نما

 ). دیفصل آمده است، مراجعه کن  نیکه در ادامه ا  "FORMULATEXTبا استفاده از 


و  Chapter01.xlsx يهال ی با دانلود فا  دیفصل کار کن نیا  يهابا تمام مثال دیتوان ی شما م یادداشت:  ݝݜݛݚ
Chapter01a.xlsx  همراه که در مقدمه ذکر شده است.   يمحتوا يهات یاز سا  کی از هر  
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 . د یخود استفاده کن يهادر فرمول ت یاولو بیکنترل ترت  ياز پرانتزها برا : 1-1شکل 

. د یاستفاده کن  کند،ی ها استفاده ممحاسبه فرمول   ي که اکسل برا  ی بیکنترل ترت  ياز پرانتزها برا  د یتوانی شما م   ،یطورکلبه 
)  تیاولو  ب ی(بر اساس ترت  ياصورت دنباله از پرانتز به   رون یعبارات ب  شوند؛ی اول محاسبه م   شه یعبارات داخل پرانتز هم

  ب یو ترت  د یها به دست آوررا در فرمول   یق یدق  جیکه نتا  دهد ی امکان را م  نیاز پرانتزها به شما ا  استفاده.  شوند ی محاسبه م
  .د یکن  می خودتنظ يازهایمحاسبات را مطابق با ن

  n  شهی ر  د ی، اگر بخواهمثالعنوانبه است.    ي عدد به توان کسر  کی خوب پرانتزها، توان بردن    ي از کاربردها  گر ید  ی کینکته:  
 :د یاستفاده کن  ریز  یاز فرمول کل  د،یعدد را محاسبه کن کی ام

=number ^ (1 / n) 

 :د یاستفاده کن ر ی، از فرمول زA1سوم از مقدار موجود در سلول  شهیمحاسبه ر ي مثال، برا يبرا

=A1  ^ )1   /3  (  

  . د یبه دست آور یقی دق  جیو نتا د یرا محاسبه کن هاشه یر یراحتبه که  دهد ی امکان را م نیروش به شما ا نیا

 nesting( درون پرانتزکار   نیکه به ا  د یقرار ده گریکد یپرانتزها را داخل  د یتوانی خود، م  يهابر فرمول  شتریتسلط ب يبرا

parenthesesدر ادامه چند فرمول  کند ی م  یابیپرانتزها را ارز  نیتری ابتدا مجموعه داخل  شهی. اکسل همشودی ) گفته م .
  :شودی نمونه ارائه م 
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 : تودرتو يمحاسبه مجموع و سپس ضرب با استفاده از پرانتزها : 1 مثال

)=3 ) +4  *2  ((^  2  

 .بردی م  2به توان   تیجمع کرده و در نها 3را با   جه ی و سپس نت کند ی ضرب م  2را در   4مثال، ابتدا    نیا در

 

 :2در  جهینت کردنضربمحدوده، و سپس  کی  نیانگیمحاسبه م: 2 مثال

2   ) *SUM(A1:A5) / COUNT(A1:A5)( = 

 . شودی ضرب م 2به   تیو در نها  میو سپس بر تعداد آن تقس شودی مجموع محدوده محاسبه م  ابتدا

 

 دوم:  شهیدو مقدار و سپس ضرب آن در ر انیمحاسبه اختلاف م : 3 مثال

=SQRT((A1 - A2) ^ 2) 

 . شودی دوم آن گرفته م  شهیر تیو در نها رسد ی م 2محاسبه شده و سپس به توان  A2و    A1ابتدا اختلاف  نجا، یا در

در    ي شتر یب  دقتبه و    د یکن  جادیرا ا   يترده یچیپ  يهاتا فرمول   دهد ی امکان را م  نیبه شما ا  تودرتو  ي از پرانتزها  استفاده
 . د یمحاسبات خود برس 

))، ابتدا 52- 5، در عبارت (( مثالعنوانبه در داخل پرانتزها برقرار است.    ز ین  ت یاولو  بیترت  ن یکه قوان  د یتوجه داشته باش 
 . شودی از آن کسر م 5و سپس مقدار   شودی محاسبه م)  52عبارت (

اکسل خود    يهابر فرمول   ی که کنترل کامل  دهد ی امکان را م  نی محاسبات به شما ا بیترت  نیی تع ياز پرانتزها برا  استفاده
باش  شو  د یتوانی م  گونهن یا.  د یداشته  پاسخ  د یمطمئن  م  ک یکه    یکه  ارائه  چ  دهد،ی فرمول  شما   ي زیهمان  که  است 

 . د یخواهی م
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از بروز خطا در نتا  د یکن  تیر یمد   یتا محاسبات را به طور مطلوب   کند ی پرانتزها به شما کمک م  ق یدق  يریکارگبه   ج یو 
  . د یکن ي ریجلوگ

  

  

  

  

  

 )Controlling worksheet calculation(  کارورق کنترل محاسبات 

  کی  يهامعمول هرگاه داده   به طورو    کند ی محاسبه م   د،یکنیم   د ییکه ورود آن را تأ  یفرمول را زمان  ک ی  شهیاکسل هم
کار کوچک مناسب   يهاورق   يرفتار برا  نی. اکند ی خودکار دوباره محاسبه م   به طور موجود را    يهاکند، فرمول   ر ییفرمول تغ

باعث   تواند ی طول بکشد، م  قه یچند دق  ی حت  ای  ه یکه محاسبه آن چند ثان  د یداشته باش   دهی چیمدل پ  کی است، اما اگر  
 :دهد ی م شنهادیرا به شما پ  دوراهمحاسبه خودکار، اکسل  نیا کردن خاموش  يکاهش سرعت شما شود. برا 

 انتخاب :Formulas > Calculation Options . 
 انتخاب :File > Options > Formulas . 

 : شودیداده م  شیشما نما ي محاسبه برا نهیهر دو شکل، سه گز به

 Automaticورود   محضبه ها را است که اکسل فوراً فرمول یمعن  نیمحاسبه است و به ا فرض ش یحالت پ نی: ا
 .کند یفرمول محاسبه م  يهاداده  رییتغ  محضبه  نیها و همچنآن

 Automatic Except for Data Tablesخودکار   به طورها را حالت محاسبات، اکسل تمام فرمول  نی: در ا
 يسازمدل  ياستفاده از ابزارها" 19مرتبط با جداول داده (که در فصل  يهابه جز فرمول کند،ی محاسبه م 

چند جدول   ای کیشما شامل  کارورق است اگر  یانتخاب خوب نهیگز ن یام). ابه آن اشاره کرده  "اکسل وکارکسب
 .شودی محاسبات م کندشدنبزرگ باشد که باعث  دادة 

 Manualکه    یرا دوباره محاسبه کند تا زمان ی فرمول گونه چ یتا اکسل مجبور نشود ه  د یحالت را انتخاب کن نی: ا
اکسل   يهانه یگز ي وگوگفت . اگر در کادر  د یکن  رهیکتاب کار را ذخ  ای د یدوباره محاسبه کن  ی صورت دستبه  ای

  د ییمحاسبه نکند، با لغو انتخاب کادر تأ وباره کتاب کار، د  ره یکه هنگام ذخ د ییبه اکسل بگو د یتوانی م د،یهست
Recalculate Workbook Before Saving . 


 ک ی بستن    کردنفراموش ها،  اشتباهات هنگام استفاده از پرانتزها در فرمول   نیترج یاز را  یکی :هشدار  ❜❛❚
حل راه   کی(و    کندی م  دیخطا تول  امیپ   کیحالت، اکسل    نی با علامت پرانتز بسته است. در ا  يعبارت پرانتز 

باز و بسته   يتمام پرانتزها  د، یارا بسته  يهر عبارت پرانتز   نکهیاز ا  نانیاطم  يبرا).  دهدی مشکل ارائه م  يبرا
 ن ی به ا  توجه  . دیاپرانتز را جا انداخته   کیکه    دیدانینباشد، م  يتعداد با هم مساو  نی. اگر ادیرا شمارش کن

 شود.  محاسباتتاندقت   شیشما کمک کند و باعث افزا  يهابه کاهش خطاها در فرمول  تواندی نکته م
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فرمول وجود    جیانت  یروزرسانبه به   ازیکند و ن   ر ییشما تغ  کارورق  يهافعال باشد، هر بار که داده   ی محاسبات دست  ی وقت
 Formulasابتدا تب    د،یدوباره محاسبه کن  د یخواهی م  ی. وقتد یکنی مشاهده م   تیرا در نوار وضع  "Calculate"داشته باشد،  

 :د یدار  نهیگز  ه، س Calculation. در گروه  د یده شیرا نما

 انتخاب :Calculate Now )فشاردادن  ای F9 باز.  کارورق دوباره محاسبه هر   ي) برا 
  :انتخابCalculate Sheet )فشاردادن  ای Shift+F9 فعال دوباره محاسبه شود.  کارورق ) تا فقط 
 کلمه   يبر رو کیکل"Calculate" معادل انتخاب    نی. (اتیدر نوار وضعCalculate Now (.است 

 یی هاو تنها قسمت  د یکار خود داشته باش  يهامحاسبات ورق  يبر رو   ي شتر یکنترل ب دهند یبه شما امکان م   هانه یگز  نیا
  نیاز ا استفاده .د یدار  دهیچیبزرگ و پ يهاکه کار با مدل  ي در موارد  ژهیوبه  د، یدارند را محاسبه کن یروزرسانبه به  ازیکه ن
  .د یعملکرد اکسل و سرعت محاسبات خود داشته باش  يبر رو   ي شتریکه کنترل ب دهد ی امکان را م نیبه شما ا ماتیتنظ

  

  

  

 

 : د یدار  نه یدو گز  د،یفعال است، دوباره محاسبه کن   یمحاسبات دست  کهی درحالخود را    کارورق از    ی تنها بخش  د یخواهی اگر م

 د ینشانگر را درون نوار فرمول قرار ده د،یفرمول را انتخاب کن  ي فرمول تنها: سلول حاو ک یدوباره محاسبه  يبرا  
 در نوار فرمول). Enterبا انتخاب دکمه  ای Enter فشاردادن (با   د یکن  د ییو سپس سلول را تأ

 سپس به  د؛یرا انتخاب کن موردنظر محدوده: محدوده  ک یدوباره محاسبه  يبراHome > Find & Select > 

Replace ي دهایکل ای( د یبرو  Ctrl+H ؛ در هر دو کادر د یرا فشار ده(Find What  وReplace With  علامت
 .د یرا انتخاب کن  Replace All  نهیگز تیو در نها  د ی(=) را وارد کن يمساو

کند.   نیگزیجا  ي گرید  ي موجود در هر فرمول را با علامت مساو  ي که علامت مساو  دهد ی امکان را م  ن یعمل به اکسل ا  نیا
 تا هر فرمول را دوباره محاسبه کند. کند ی اما اکسل را مجبور م دهد،ی نم ر ییرا تغ یفرمول  چ یعمل در واقع ه نیا

 

 

  

اند، در تمام نکرده   رییکه تغ  ییهافرمول  یاکسل هر فرمول را دوباره محاسبه کند، حت  دیخواه یاگر م :نکته
باز، م  يهاورق  به شما کمک    دیکل  بیترک  نیا  . دیرا فشار ده  Ctrl+Alt+Shift+F9  يدهایکل  د یتوانیکار 

نتا  دیتا مطمئن شو   کندیم بهفرمول  ج یکه همه  با آن  يهااگر داده   یاند، حتروز شده ها  تغمرتبط   ر ییها 
  نکرده باشد. 
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 هافرمول  ییجاجابه و  یکپ

 نابجاو    ی را کپ  يعاد  يهاکه محدوده   ی ها هستند را به همان روش که شامل فرمول   ییهاو محدوده   ری مقاد  د یتوانیم  شما
 .ستند یواضح ن  شه یهم جیاما نتا د،یکن جاجابه و  ی کپ د،یکنی م

  C11. فرمول موجود در سلول  دهد ی شرکت را نشان م کی  يبرا يانه یهز يهااز داده  ست یل ک ی  2- 1، شکل مثالعنوانبه 
عدد  ک یمحاسبه   کارورق   ن یپشت ا  ده ی. اکند ی استفاده م  ه یماه ژانو  يهانه یمحاسبه مجموع هز   ي برا   SUM(C6:C10)از  

 است.   2021سال  ی مجموع واقع شیافزا  از  يدرصد  عنوانبه   2022سال  ي برا د یجد  نهیبودجه هز

که عدد    یدرصد است.) فرمول   3  مورداستفاده  ش یحالت، افزا  نی . (در ادهد ی م  شیرا نما  INCREASE  ر یمتغ  C3  سلول
BUDGET    سلول    کند ی را محاسبه م  2022سال)C13  در    2021مجموع    کردن ضرب ) با  هیماه ژانو   يبراINCREASE  

 ).C11 * C3=  ،یعن ی( شودی انجام م

 ها: فرمول  ییجاجابه و   یکپ يبرا  ینکات

  ن یبه ا  دارد، ی نگه م  ی ها را نسبآدرس   فرض ش یپ  به طور اکسل    د،یکنی م  ی فرمول را کپ  کی   ی وقت  :ینسب  يهافرمول
 .کنند ی م  رییتغ د یها نسبت به مکان جد که آدرس   یمعن

مطلق    يهاآدرس   جادیا  ي برا  $از علامت    د یتوانی نکنند، م  رییها تغآدرس   د یخواهی اگر م  :یب یمطلق و ترک  يهافرمول
 یی جاجابه و   یبر نحوه کپ يشتریکار به شما کنترل ب  نی. اد ی) استفاده کنC3$ ای C$3(مانند  یبیترک  ای) C$11$(مانند 
 .دهد ی ها مفرمول 


که در آن،   کندی م   یبانی) پشتmultithreaded calculation(   یسمانیچند ر اکسل از محاسبات   :نکته  ࢘ࢗ࢖࢕࢔
  کندی م  يانداز) راه thread(  رشتهکی  اکسل  -ه  هر هسته پردازند  تر، ق یبه طور دق  ای  -ه  هر پردازند  يبرا

به  پردازش محاسبات متعدد    ياز هر رشته موجود برا   تواندی م  اکسلاست.    ییاجرا   يمجزا  ندیفرا   کیکه  
  ير یبه طرز چشمگ  تواندیم   نیمستقل متعدد، ا   يهابا فرمول  کارورق   کی   ياستفاده کند. برا  زمانهم   طور

 نان یاطم  يفعال است، اما برا  فرضش یپ  به طور  یسمانیچند ردهد. محاسبات    شی سرعت محاسبات را افزا
ا به مس  نی از  در بخش    دیبرو  File > Options > Advanced  ریموضوع،  اطمFormulasو سپس   نان ی، 

کن تأ  دیحاصل  کادر  باشد.   Enable Multi-Threaded Calculation  دیی که  شده    ت یقابل  نیا  انتخاب 
  ش یکار بزرگ را افزا  يهاورق   ییو کارا  دیبه شما کمک کند تا زمان محاسبات خود را کاهش ده  تواندیم

  . دیده
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 جاجابه   ای  د یکن  ی کپ  موردنظرگوشه سلول، فرمول را به نقطه    دنیبا کش  د یتوانی م  :Drag and Dropبا    ییجاجابه و    یکپ
 .د یکن

 جیو نتا  د یها به طور مؤثر استفاده کناز فرمول   د یتوانی م  د،یکنی م   تیریها را مد ها و فرمول که داده   ی وقت  ،بیترتنیابه 
  .د یبه دست آور ی قیدق یمحاسبات

  
 است: شدهداده نشان  ه یاعداد ماه ژانو يبا دو محاسبه برا هانه یبودجه هز  کارورق  ک ی نجایا 2-1شکل 

): که با  C13سال بعد (سلول    يبرا  شیافزا  درصد   .دهد ی را نشان م  ه یماه ژانو  يهانه ی ): که مجموع هزC11(سلول    جمع
  کار ورق  نیا  .کند ی ) ضرب مC3(در سلول    شدهن ییتع  شیرا در درصد افزا 2021، مجموع  C11 * C3استفاده از فرمول =

 .  د یانجام ده نده یسال آ ي را برا یمال  يهاینیبشی دنبال کرده و پ یراحتبه را  هانه یهز دهد ی به شما امکان م

  خود درك کنند.  ندهیرا در بودجه آ يانه یهز راتیی تغ ی مال رات یتا تأث کند یبه افراد کمک م  یطراح نیا

هر    د یتوانی است. شما م   ه یماه فور  يبرا   BUDGET 2022و رقم    TOTAL 2021  يهانه یمحاسبه مجموع هز  ي بعد   مرحله 
را نشان   ی زمان  ج ینتا  3-1  شکلاست.    ترع ی سر  مراتببه سلول    کی   کردن ی کپاما    د، یوارد کن  یصورت دسترا به   د یفرمول جد 

 D11فرمول در    د،یکنیطور که مشاهده م. هماند یکنی م  یکپ  D11را به سلول    C11سلول    اتیکه شما محتو  دهد ی م
 عبارت است از:
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=SUM(D6:D10) 

 جمع شود.   ه ی فور يهانه یکرده است تا فقط هز م یاست که اکسل دامنه موجود در تابع فرمول را تنظ ی بدان معن نیا

 داند؟ یکار را م  نیاکسل ا  چگونه

فرمول    کیکه شما   یقالب، هنگام نی. در اد یاکسل آشنا باش   یبا قالب مرجع نسب   د یسؤال، شما با  ن یبه ا  دادنپاسخ  يبرا
اگر شما   ،گریدعبارتبه .  کند ی م  میتنظ   د یجد   ت یسلول را بر اساس موقع  يهاخودکار آدرس   طوربه  اکسل    د،یکنی م  ی را کپ

  تیکه با موقع کند ی م  میتنظ ياگونه اکسل دامنه را به  د،یکن یدهد را کپی ارجاع م یخاص يهات یفرمول که به موقع کی
 خود مطابقت داشته باشد.  د یجد 

هر ماه   يها برافرمول   یدست  واردکردن به  از یشما ن را یکارآمدتر باشد، ز اریها بسکه کار با فرمول   شودی باعث م تیقابل نیا
 يهامربوط به مرجع   اتی! در ادامه، در بخش مربوطه به جزئد یرا اعمال کن   راتییتغ  یراحتبه   د یتوانی داشت و م  د ینخواه

  پرداخت. می اکسل خواه ینسب

  
خودکار مرجع دامنه   به طوراکسل  د،یکنی م ی کپ  هی فور  يرا برا 2021  هی ژانو TOTALکه شما فرمول   یوقت  3-1شکل 

)range referenceکند ی م م ی ) را تنظ. 
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 خواهد بود:  ریز صورتبه  D11، فرمول در D11به سلول   C11فرمول از سلول   کردن ی کپ، با مثالعنوانبه 

=SUM(D6:D10) 

  نکهیبدون ا   دهد،ی ارجاع م  هی مربوط به ماه فور  يهانه یخودکار به هز  به طورکه فرمول    دهد یاکسل نشان م   يهوشمند   نیا
و با حداقل خطا    ترع ی را سر  هانه یمحاسبه هز  ند یتا فرا  کند ی به شما کمک م   ی ژگیو  نیفرمول باشد. ا  ی دست  ش یرایبه و  ازین

  . د یانجام ده

 ی درك قالب مرجع نسب

 ی فرمول بررس   ت یاکسل آدرس سلول را نسبت به موقع  د، یکنیفرمول استفاده م   ک ی در    ی مرجع سلول  ک یکه شما از    ی وقت
سلول    اتیمحتو":  د یگوی فرمول م   نی قرار دارد. به اکسل، ا  A3در سلول    A1 * 2فرمول =  د ی، فرض کنمثالعنوانبه .  کند ی م

  فرض ش یو فرمت پ  شودی شناخته م  ی قالب مرجع نسب عنوانبه قالب  ن یا "ضرب کن. 2سلول را در   ن یبالاتر از ا ف یدو رد 
شکل خواهد   نیهنوز هم به ا  یمرجع نسب   د،یکن  یکپ  A4فرمول را به سلول    نیمعنا که اگر ا  نیاکسل است. به ا  يبرا

دو    A2  رایز  ابد،یی م  رییتغ  A2 * 2، اما فرمول به = "ضرب کن  2سلول را در    نیبالاتر از ا  فی سلول دو رد  اتیمحتو"بود:  
  C11بود فرمول در سلول    ی است. شما فقط کاف  د یفرمت مف  نی که چرا ا  دهد ی نشان م  4-1  شکل  است.   A4  ي بالا  ف یرد

 يهانه ی مجموع هز آوردن دستبه  يانجام شد. برا  یدرستبه  زیهمه چ ،یو به لطف مرجع نسب  د یکن ی کپ D11را به سلول 
را در    ي ادیز  اریزمان بس  تواند ی م  ي برداری روش کپ  نی. اد یبچسبان  E11همان فرمول را در سلول    د یماه مارس، تنها با

 کند.  ییجوشما صرفه  يبرا  کارورق  يهاساخت مدل

 هافرمول  ییجاجابه و  یدر کپ اطیاحت

بودجه    کارورق اگر شما به    افتد ی م  ی چه اتفاق  مینیبب  د ییای. بد یکن   اطیها احتفرمول   ییجاجابه  ای  یهنگام کپ  د یشما با  اما
که    دهد ی نشان م  4- 1. شکل  د یکن  یکپ   D13را به سلول    C13در سلول    BUDGET 2022فرمول    د یکن  ی و سع  د یبازگرد

 است!(صفر)   0 جه ینت

 افتاده است؟ یاتفاق چه

است که    2021  ه یفور  يهانه یمجموع هز  D11است. سلول    D11 * D3=  د ی: فرمول جد دهد یفرمول مشکل را نشان م   نوار
  ی خال  يها. اکسل سلول دهد ی ) ارجاع مD3(  یسلول خال  کی، فرمول به  INCREASE (C3)سلول    يجابه خوب است، اما  

شد،    یکه فرمول کپ   ی است. وقت  ی. مشکل در قالب مرجع نسبتاس   0فرمول    جهینت  نیبنابرا  رد، یگی در نظر م  0  عنوانبه را  
 ارجاع دهد. D3به سلول  د یبا د یاکسل فرض کرد که فرمول جد 
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 مشکل با مرجع مطلق  حل

که    د یقالب مرجع مطلق، آشنا شو  گر،یفرمت د  کیبا    د یبا  د،یمشکل را اصلاح کن   نیا  د یتوانی چگونه م  نکه یا  دن ید  يبرا
  د، یسلول اشاره کن  ک یبه طور خاص به    که  دهد ی امکان را م  نی . مرجع مطلق به شما امیپردازی به آن م   ي در بخش بعد 

  نکند. رییغفرمول، ارجاعات ت کردنی کپکه هنگام   ياگونه به 

  

  
 . شودی مشکل م ک یباعث بروز  ه یبه فور 2022  هیژانو BUDGETفرمول   کردنی کپ 4-1شکل 

فرمول    یاست که وقت   نیامر ا  نیاست. علت ا  0برابر با    D13فرمول در سلول    جهیکه نت  د یکنی شکل، مشاهده م  نیا  در
=D11 * D3    خودکار مرجع را به سلول    صورتبهاکسل    افت،یانتقالD3  محاسبه    يبرا  رای کرد. ز  میاست، تنظ  یکه خال

ارجاع داده شده    یسلول خال  کیآن، به    يجابه بود، اما    INCREASE (C3)به ارجاع به سلول    ازی، ن2022سال    يهانه یهز
 است. 

به    ازی که ن  ي در موارد  ژهیوبه ها،  فرمول  کردن ی کپدر    ، نی؛ بنابرااست  ی از عدم توجه به مرجع نسب  یمشکل ناش   ن یا  نکته
مشابه، لازم است   ياز بروز خطاها  ير یمشکل و جلوگ  نیحل ا  ي. براد یکن  اطیاحت  د یبا  د،یدار  یخاص  يهاارجاع به سلول 
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تا مرجع به    دهد ی فرمت به شما امکان م  ن یداده خواهد شد. ا  ح یضتو يکه در بخش بعد   د یشنا شو با قالب مرجع مطلق آ
  نکند. ر ییفرمول تغ یسلول خاص ثابت بماند و هنگام کپ  کی

  

  

.  دهد ی م  رییو فقط مکان فرمول را تغ  دهد ی نم  ر ییرا تغ  یسلول   يها فرمول، اکسل آدرس   ییجاجابه در هنگام    ،گریدعبارتبه 
در    یرات ییتغ  نکه یبدون ا  د یاستفاده کن  د یمکان جد   ک یدر    ی از فرمول  د یاست که شما بخواه  د یمف  یزمان  ژه یوبه   ی ژگیو  نیا

مراجع    د یو بخواه  د یمنتقل کن  گریمکان به مکان د  ک یرا از    ی فرمول  د یدار  ازیاگر ن   ،نی؛ بنابراشود  جاد یا  ی مراجع سلول
  خواهد بود.   ی مناسب نه یفرمول گز ییجاجابه بمانند،  ی همانند قبل باق

 درك قالب مرجع مطلق 

سلول    یک یزیاکسل از آدرس ف  د،ی کنی سلول با استفاده از قالب مرجع مطلق اشاره م  ک یفرمول به    ک یکه شما در    ی وقت
 د یخواهی که م   د ییگوی و ستون آدرس سلول به برنامه م  فی ) قبل از رد$دلار (  يهاعلامت   قراردادن . شما با  کند ی استفاده م

 اتیمحتو"  عنوانبه را    A$1 * 2$اکسل فرمول =   ، یبازگشت به مثال بخش قبل   ي برا  .د یمرجع مطلق استفاده کن  ک یاز  
مرجع سلول    د،یکن  جاجابه   ای  یفرمول را به کجا کپ  نیکه شما ا  ستی. مهم نکند ی م  ر یتفس  "ضرب کن   2را در    A1سلول  

 اصطلاح لنگر شده است.حالت به  نینخواهد کرد. آدرس سلول در ا رییتغ

 بودجه  يهانه یصفحه اکسل هز  اصلاح

فرمول    د یکار، ابتدا با  نیا  ي. براد ی را لنگر کن  INCREASE  ری متغ  د یبودجه، شما با  يهانه ی اصلاح صفحه اکسل هز  يبرا
BUDGET را در سلول  2022  هیژانوC13  د یده رییتغ ر یز صورتبه : 

=C11 * $C$3 

 :کند ی م د یرا تول ریز د یفرمول جد  2022 ه یفور BUDGETفرمول به ستون   کردنی کپ  ر،ییتغ ن یاز انجام ا پس

=D11 * $C$3 

نخواهد   ر ییشده است و تغ  ن ییمطلق تع  صورتبه حالا    C3مرجع به سلول   را یز  کند،ی م   د یرا تول  حیصح  جه یفرمول نت  نیا
 کرد. 

 


فرمول   کی شما  یفرمول رخ نخواهد داد. وقت کی  ییجاجابه هنگام  یمشکل قالب مرجع نسب :نکته ࢘ࢗ࢖࢕࢔
   . دیرا حفظ کن ی همان مراجع سلول  دیخواهیکه شما م کندی اکسل فرض م د، یکنیم جاجابه را 
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  يها ها، به سلول فرمول  ییجاجابه  ای ی که هنگام کپ دهد ی امکان را م نیاز مرجع مطلق به شما ا استفاده  ي:ریگجهینت
به محاسبات بر اساس  از یکه ن ییهات یخصوص در موقعاست به  د یمف ار یبس یژگیو نی. اد یخاص و مراجع ثابت اشاره کن 

  ثابت وجود دارد.  يهاداده 

  

  

  

  

اند شده  م یدر صفحه اکسل تنظ  یدرستبه محدوده    يهاکه نام   د ی حاصل کن  نانیمحدوده: اطم  يهانام   ت یریمد   :مهم  نکته
  شود.   ير یمحدوده نادرست جلوگ  يهااز ارجاع به نام   یتا از بروز اشتباهات ناش   د یکن  یها را بررس آن   از،یو در صورت ن

  یدرستبه ها  که فرمول   د یتا مطمئن شو  د یکن  یرا بررس   جهینت  شه یها، همفرمول   ییجاجابه   ا ی  ی: بعد از کپ جهینت  یبررس 
از مراجع    یکه برخ  د یدار  ازی: اگر نیاز مراجع مطلق و نسب   استفاده  .کنند ی اشاره م  موردانتظار  ریو به مقاد  کنند ی کار م

  .د یاستفاده کن  ی مراجع مطلق و نسب  بیثابت بمانند، حتماً از ترک ی کنند و برخ  رییتغ

صفحات   یی و کارا  د یکن  ي ریمحدوده جلوگ  يهااز استفاده نادرست از نام   یناش   ياز خطاها  د یتوانی نکات، م  نیا  تیرعا  با
  . د یده ش یاکسل خود را افزا

 ی بی درك قالب مرجع ترک

فرمت،    نی. در اد یوارد کن  یبیرا با استفاده از قالب مرجع ترک  یمرجع سلول  کی  د یتوانی که م  د یبدان  د یبا  نیهمچن  شما
  ا ی )  B$6  مثال،عنوان به   - ف  ی آدرس رد  ي علامت دلار فقط در جلو   قراردادن (با  د یسلول را لنگر کن  ف یرد  ا ی  د یتوانی شما م

 ). B6$ مثال،عنوانبه  -ن  آدرس ستو  يدلار فقط در جلو مت علا قراردادن (با   د یستون آن را لنگر کن

 :هامثال

  6  فی شماره رد  گر،ید  يهاآن به سلول  کردنی کپهنگام    د،یداشته باش   B$6مانند =  یشما فرمول   اگر  :فیکردن رد  لنگر
صورت    ن یبه ا  د، یکن  ی کپ  C7فرمول را به    نیاگر ا  گر، یکند. به عبارت د  ر ییثابت خواهد ماند، اما ستون ممکن است تغ

 . C$6خواهد کرد: = رییتغ

ممکن است  فیثابت خواهد ماند، اما رد Bشماره ستون  د،یداشته باش  B6$مانند = یشما فرمول اگر کردن ستون: لنگر
 . B7$خواهد کرد: = ر ییصورت تغ نیبه ا د،ی کن ی کپ  C7فرمول را به  نی، اگر امثالعنوانبه کند.   رییتغ


 ی بدان معناست که هنگام  نی مطلق اشاره دارند. ا   یمحدوده به مراجع سلول   يهااز نام  يار یبس :هشدار  ❜❛❚
شده همان نام محدوده   یفرمول کپ  د، یکنی م   یکپ  کندینام محدوده استفاده م   کی را که از    یکه شما فرمول 

در صفحه اکسل   طاممکن است منجر به بروز خ   نی. ابردی استفاده کرده است، به کار م  ی را که فرمول اصل
 ما شود. ش



 )فدریزپل مک : مایکروسافت اکسل (نویسنده 

 مترجم: محمدصادق خوشنامی

 هاي پایه ساخت فرمول : 1فصل 

   

  
 WWW.Landofexcel.com                                                                        36  از  20  صفحه

 info@landofexcel.com 

 

 

  ي شتریب  يریپذ که انعطاف   دهند یامکان را م  نیبه شما ا  یبیترک  يهامرجع :  دهیچیپ  معادلات  ی:ب یمرجع ترک  يکاربردها
 .د یکنی اند کار م شده یکه در قالب جدول سازمانده ییهاکه با داده   یهنگام ژه یوبه  د،یخود داشته باش  يهادر فرمول 

  به طور فرمول    ه یبق  که ی درحال  د یثابت نگه دار   یخاص  يهاستون   ای  هاف یرا در رد  ر یمقاد  د یتوانی شما م  داده:  لیتحل
 است.   د یمف اریها بسداده   لیتحل يبراکه  کند ی م ر ییتغ  کینامید

 دیخود داشته باش   يهابر فرمول   يشتر یبه شما کمک کند تا کنترل ب  تواند ی م  یب یترک  يهااز مرجع   استفاده   ي:ریگجهینت
و دقت کار با صفحات اکسل را    یی کارا  د یتوانی فرمت، م  نیا  ي ر یکارگبه . با درك و  د یکن  تیریها را مد داده   یراحتبه و  

  . د یده شیافزا

  

  

  

  

 ی به چند آدرس سلول دیفرمت جد  اعمال

 :د یاعمال کن  یآدرس سلول نیمرجع را به چند  د یفرمت جد  د یخواهی م اگر

 د یرا انتخاب کن  موردنظر يهاآدرس  ها:آدرس  انتخاب. 
 فشردن F4: د یکل F4 د ین یرا بب موردنظر که فرمت   ی تا زمان  د یرا فشار ده. 
 فشردن Enter: د یکل Enter شود.  رهیذخ  رات ییتا تغ د یرا فشار ده 

 F4استفاده از  يایمزا

 ش یرایبه و از ین نکهی بدون ا د یده ر ییفرمت مرجع را تغ  عاًیکه سر کند ی روش به شما کمک م ن یا :سرعت  
    .د یداشته باش  یدست

 د یارا انتخاب کرده  ح یکه فرمت صح د یمطمئن شو د یتوانی ها، مبا چرخه زدن در فرمت :دقت. 

  در اکسل باشد. ی ها و مراجع سلولشما در هنگام کار با فرمول  ییدر بهبود کارا يد یابزار مف تواند ی م  د یکل نیا

 

 


از کل  کی فرمت مرجع    سرعتبه  دیتوانی شما م :نکته  ࢘ࢗ࢖࢕࢔ استفاده  با  را  . دیده   رییتغ  F4  دیآدرس سلول 
 .دیقرار ده  و ستون)  فیرد  ریمقاد  نی(ب  فرمول، نشانگر را به سمت چپ آدرس سلول  کی   شیرایهنگام و

از فرمتدیبار فشار ده  نیرا چند  F4  دیکل به طور خودکار  اکسل  (نسب  يها.  و   ، یمختلف مرجع  مطلق، 
 . دیرا فشار ده Enter دیکل د، یخود را مشاهده کرد موردنظرکه فرمت  یزمان . زندی ) چرخه میبیترک
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 ی مراجع نسب  رییفرمول بدون تغ  کردنیکپ

 :د یرا دنبال کن ری کنند، مراحل ز ر ییفرمول تغ ی مراجع نسب د یخواهی اما نم د یکن ی فرمول را کپ  کیکه  د یدار  ازین اگر

 . د یرا که شامل فرمول مورد نظر است انتخاب کن یسلول: سلول  انتخاب -  1

 . د یدادن نشانگر در نوار فرمول: نشانگر را در داخل نوار فرمول قرار ده قرار  -  2

 . د یکل فرمول را انتخاب کن د،یصفحه کل ایکل فرمول: با استفاده از ماوس   انتخاب -  3

  نهیو انتخاب گز کیکلبا راست ای Ctrl + C(با فشار دادن    د یکن  یکردن فرمول: فرمول انتخاب شده را کپ  یکپ -  4
Copy.( 

 شود.  رفعالیتا نوار فرمول غ  د یرا فشار ده Escکردن نوار فرمول: دکمه  رفعال یغ -  5

 . د یاز فرمول در آن ظاهر شود، انتخاب کن یکپ د یخواهی را که م یسلول مقصد: سلول انتخاب -  6

  نهیو انتخاب گز کیکلبا راست ای Ctrl + V(با فشار دادن    د یبچسبان د یفرمول: فرمول را در سلول جد  چسباندن -  7
Paste.( 

  کیتکن  نینخواهد کرد. ا  رییو تغ  ماند ی م   یباق  یشده به همان فرمت و مراجع اصل  یروش، فرمول کپ   نیا  با  ي:ریگجهینت
  است. د یمف اریثابت بمانند، بس یمحاسبات خاص د ی دار ازیکه ن  ی در مواقع  ژهیوبه 

  

  

  

  

  

 

 

 


 ینسب   یمراجع سلول   رییفرمول بدون تغ  کی  کردنی کپ  يبرا  دیتوانیکه م  گریدو روش د  نجایدر ا  :نکته  ࢘ࢗ࢖࢕࢔
 آمده است:  د، یاستفاده کن

 بالا  کردنیکپ انتخاب کن  ینییپا  سلول:  یی از سلول  را فشار    Ctrlو سپس    دیرا  ’ (آپاستروف)   +
مراجع    نکهیبدون ا  دی کن  ی کپ  سرعت به را    ییفرمول سلول بالا  دهدیکار به شما اجازه م  نی . ادیده

 کند.  رییآن تغ
  در سمت   فرمول يآپاستروف (‘) را در ابتدا کی و  دیفرمول را فعال کن نوار از نوار فرمول: استفاده)

  د ییتأ   شیرایتا و  دیرا فشار ده  Enterشود.    لی تا فرمول به متن تبد  دیکن   پی تا  چپ علامت برابر)
آپاستروف را از هر دو سلول    حالا   . دیبچسبان  موردنظرکرده و در مکان    ی سلول را کپ  سپس  شود. 

 شوند.  لی تا دوباره به فرمول تبد   دیمنبع و مقصد حذف کن
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  تواند یم که    د یکن  یکپ   ی مراجع نسب  ر ییو بدون تغ  یآسانبه ها را  تا فرمول   دهند ی ها به شما امکان مروش   نیا  :يریگجهینت
  باشد. د یمف اریها بسداده  ي دقت و سازگار  يدر نگهدار

 صفحه اکسل يهافرمول  شینما

فرمول    کی که    د یدار  از یخود فرمول. اگر ن  يجابه   دهد ی م  شیفرمول را نما  جیسلول نتا  کیاکسل در    فرض، ش یطور پ  به
مواقع ممکن است  ی ، در برخحالنیباا. د یفرمول را انتخاب کرده و به نوار فرمول نگاه کن ي سلول حاو د یتوانی م  د، ینیرا بب

 ).د یهست یابیب یکه در حال ع  ی، زمانمثالعنوانبه ( د ی مشاهده کن سلصفحه اک کی ها را در  همه فرمول  د یبخواه

 ها در صفحه اکسل همه فرمول  شینما

 :د یکن  ي رویپ ریصفحه اکسل، از مراحل ز کیها در تمام فرمول  شینما يبرا

 Show Formulas نه یگز ي ها: روفرمول   شینما نهیگز انتخاب .د یبرو Formulas (Tab)به برگه  ها:تب فرمول  انتخاب
بازگشت  ي. برادهد ی م شیها نماآن  جینتا يجابه ها را در صفحات اکسل کار، اکسل همه فرمول   نیانجام ا با .د یکن  کیکل

 . د یکن کیکل Show Formulas ي است دوباره رو ی کاف ج، ینتا دنیو د  يبه حالت عاد 

 هافرمول  شینما  يایمزا

 . ریخ ایاند نوشته شده  یدرستبه ها فرمول   ایکه آ  د یکن ی بررس  یراحتبه  د یتوانی م  :یابیب یع

 . د یخود را بهتر درك کن ي تای به شما کمک کند تا ساختار د تواند ی موجود م يهافرمول  یبررس  : لیوتحله یتجز

 .د یکن  ییارجاعات نادرست را شناسا ایخطاها  سرعتبه   د یتوانی م  خطاها: ییشناسا

  دهد.   شیها در صفحات اکسل افزاداده  ل یو تحل تیری شما در مد  یی کارا یتوجهقابلبه طور   تواند ی م  یژگ یو نیا

  

  

  

 

 


  ک ی  تی وضع  رییتغ   ي(آپاستروف معکوس) برا   `+    Ctrl  دیکل  بیاز ترک  دیتوانیم  نی شما همچن :نکته  ࢘ࢗ࢖࢕࢔
 . دیها استفاده کنفرمول  شیو نما ج ینتا شینما نیصفحه اکسل ب
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 `+  Ctrlاز  استفاده 

همان   فشاردادنو دوباره با  د یها را در صفحه مشاهده کنهمه فرمول  سرعتبه  د یتوانیشما م  د،یکل  بیترک نیفشردن ا با
 . د یبرگرد جینتا شیبه حالت نما د،یکل  بیترک

 روش: نیا  يایمزا

 نه یو انتخاب گز فرمولاز رفتن به تب  ترعیروش سر ن یا :یو راحت  سرعت Show Formulas .است 
 جاجابه ها و فرمول  جی نتا شینما نیب یراحتبه کار  ن یتا در ح دهد ی روش به شما اجازه م نیا در کار: یراحت 

 باشد. د یمف  ل یوتحله ی تجزو   یابیب یع ي برا تواند ی مکه  د یشو

  .د یده  شیخود را در استفاده از صفحات اکسل افزا یی کارا د یتوانی م ، یبیترک  يهاد یکل  نیاستفاده از ا با

 FORMULATEXTسلول با استفاده از تابع  کی فرمول  شینما

چند سلول   ای کیها را فقط در  فرمول د یصفحه، ممکن است بخواه کیها در تمام فرمول  شینما يجابه مواقع،  یبرخ در
 د یها را بخواهفرمول   یممکن است برخ  د،یدهی ارائه م   گرانید  يصفحه اکسل را برا   کیکه    ی، وقت مثالعنوانبه .  د ینشان ده
از تابع    د یتوانی موارد، م  نیا  در.  ند ی ها را ببمخاطب آن   د یخواهیوجود داشته باشد که نم  یخاص  يهااما فرمول   د،ینشان ده

FORMULATEXT د یسلول خاص استفاده کن ک یفرمول  شینما يبرا . 

 FORMULATEXTاستفاده از تابع  نحوه 

 FORMULATEXT(cell) تابع: ساختار

cellد یده شی فرمول آن را نما د یخواهی است که م ی: آدرس سلول . 

استفاده    ریاز تابع ز  ی سلول خال  کی در    د یتوانی . مد یده  شیرا نما  A1فرمول سلول    د یخواهی شما م  د یکن  فرض  :مثال
 :د یکن

=FORMULATEXT(A1) 

 . شودی داده م شیکه تابع در آن قرار دارد، نما یدر سلول  A1فرمول سلول  يتابع، محتوا  نیاستفاده از ا با
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 FORMULATEXTاستفاده از  يایمزا

 شیو از نما د یانتخاب کن  د،یده شینما د یدار لیرا که تما یخاص يهافرمول د یتوانی م  :شتریب کنترل  
 . د یینما ير یجلوگ گر ید يهافرمول 

 نیاکه  د یبگذار شیبه نما یسادگبه  د یدار ازیرا که ن ییهافقط فرمول  د یتوانی در هنگام ارائه، م تر:واضح  ارائه  
 .کند ی م ل یشما را تسه يکار درك مخاطبان از محتوا

  ي ضرور  يها، فرمول حالنیدرعو    د یصفحه اکسل پنهان کن  کی تا اطلاعات حساس را در    کند ی به شما کمک م  یژگ یو  نیا
  .د ینشان ده یراحتبه را 

 سلول  کی متن فرمول از  شینما

 :دهد ی م شیرا نما D9متن فرمول موجود در سلول  ر یمثال، فرمول ز يبرا

=FORMULATEXT(D9) 

 فرمول به مقدار  لی تبد

  نی. اد یکن   لیفرمول را به آن مقدار تبد   د یتوانی نخواهد کرد، م  ر ییباشد که مقدار آن هرگز تغ   یسلول شامل فرمول  ک ی  اگر
برا  آزادکردن صفحات گسترده و    محاسبهی ببه    دنیبخشسرعت کار موجب   مقدارها   را یز  شود،ی صفحه شما م  ي حافظه 

به فرمول  برکنند ی مصرف م   يها حافظه کمترنسبت    یی هافرمول  ،يااز صفحه گوشه   یمثال، ممکن است در بخش  يا. 
با   د ی توانی م  کنند،ی نم  رییاعداد احتمالاً تغ  نیجا که ا. از آن کنند ی استفاده م  یقبل  یسال مال  ر یکه از مقاد  د یداشته باش 

 : د یرا دنبال کن ر یکار، مراحل ز  نیانجام ا ي برا .د یکن لیتبد  رشانی ها را به مقادفرمول  نانیاطم

 . د یکه شامل فرمول است را انتخاب کن  یسلول: سلول  انتخاب -  1

  د یتوانی م  نیفعال شود. (همچن ی درون سلول ش یرایتا و د ی را فشار ده F2 د ی: کلیدرون سلول ش یرایو يسازفعال  -  2
 < File > Optionsروش کار نکرد، به  نی. اگر اد یباز کن شی رایو  يسلول آن را برا يکردن بر رو   کیبار کلمعمولاً با دو

Advanced نه یو گز د یبرو Allow Editing Directly In Cells د یرا انتخاب کن (. 

  . کند ی م ر یی: فرمول به مقدار خود تغF9دادن   فشار -  3

  .دهد ی م ر یی. اکسل سلول را به مقدار تغد یرا انتخاب کن  Enterدکمه  ای  د یرا فشار ده Enter د ی: کلراتیی تغ د ییتأ  -  4
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 مکان  نیفرمول در چند  کی جهیاز نت  استفاده 

وجود دارد،    C5در سلول    ی، اگر فرمولمثالعنوان. به د یمحل استفاده کن  نیفرمول در چند   کی   جهیکه از نت  د یدار  ازین  اغلب
  جه ی که نت  د یکنی روش است اگر فکر م   ن یبهتر  ن ی. اد یده  شیها نماسلول   ر یدر سا  = C5  واردکردن آن را با    جه ینت  د یتوانی م

  اما .  کند ی م  ی روزرسانرا به   گرید  يهاباشد، اکسل به طور خودکار سلول   گونهنیا  ر اگ  رایکند، ز  ر ییفرمول ممکن است تغ
انجام    ي . برا د یکن  ی کپ  گرید  يهافقط مقدار فرمول را به سلول د یتوانی نخواهد کرد، م ر یی تغ جه ی که نت  د یاگر مطمئن هست

 :د یرا دنبال کن ر یکار، مراحل ز نیا

 . د یکه شامل فرمول است را انتخاب کن  یسلول: سلول  انتخاب -  1

 ).Ctrl + C(با استفاده از   د یکن  یکردن سلول: سلول را کپ  یکپ -  2

 .د یرا انتخاب کن د ی کن  ی ها کپمقدار را به آن  د یخواهی که م ییهاسلول  ایسلول مقصد: سلول  انتخاب -  3

. د یرا انتخاب کن  Paste Values  نهیو سپس گز  د یچسباندن را باز کن  ستیل  د،یبرو  Homeچسباندن: به    نه یگز  انتخاب  -   4
 . چسباند ی شما م ی اکسل مقدار سلول را به هر سلول انتخاب

  نه یو گز  بازکرده چسباندن را    يهانه یگز  ست یسپس ل  د،یکرده و در مقصد بچسبان  ی است که سلول را کپ  ن یا  گر ید  روش 
Values Only د ی را انتخاب کن . 

بر   يشتر یو کنترل ب  د یدر صفحات اکسل کار کن  ر یها و مقادبا فرمول ي مؤثرتا به طور   کنند ی ها به شما کمک مروش  نیا
  .د یخود داشته باش  يهاداده  ي رو

  

  

  

  صورت به   د یو شما با  کند ینم  روزبه ها را  خودکار فرمول   به طوراکسل    ،یحالت محاسبه دستدر    رایدارد؛ ز  تینکته اهم  نیا
 .  د یکن  یرا کپ  يو به روز  ق یدق  ریتا مقاد   د یکار را انجام ده  نیا یدست

نادرست در محاسبات   ای  ی میقد   ری از استفاده از مقاد   یتا از مشکلات ناش   کند ی به شما کمک م   اط یاحت  نیاي:  ریگجه ینت
  .د یحاصل کن نانیخود اطم يهاتا از دقت و صحت داده  د ی نکته را در نظر داشته باش  نی . حتماً اد یکن  ي ریخود جلوگ

 


به حالت محاسبه دست  اگر   :هشدار  ❜❛❚ اکسل شما  منو  میتنظ   یصفحه  (به  است   < Formulas  يشده 

Calculation Options > Manual  د ی حاصل کن  نانیها، حتماً اطمفرمول   ریکردن مقاد  ی)، قبل از کپدیبرو 
 ). F9(با فشار دادن  دیاکرده  یروزرسانخود را به يهاکه فرمول
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 هادر فرمول يابازه  يهابا نام کار

 Sales - Expensesکه شامل فرمول =   ی، سلولهرحالبه .  د یکنیاستفاده م   يابازه  يهاخود از نام   يهااحتمالاً در فرمول   شما
را به شما نشان   کیچند تکن  يبعد   يهارا دارد. بخش   =F12 - F3  ترده یچیاست که فرمول پ  ی از سلول  ترفهمقابلاست،  

 .کند ی تر مها را آساندر فرمول  يابازه  يهاکه استفاده از نام  دهد ی م

 نام به فرمول کی چسباندن

. اما اگر نام را  د یکن  پ یاست که نام را در نوار فرمول تا  ن یفرمول ا  کیدر    يانام بازه   ک ی  واردکردن   ي ها برااز راه   یکی
دارد    یژگیو  ن یاکسل چند   ها،تینوع موقع   ن یا  يبرا   د؟یدار  يباشد و شما مهلت کار  یاگر نام طولان  ایچه؟    د یاورین  خاطربه 

. فرمول خود را  د یآن را به فرمول بچسبان  ماً یو مستق  د یانتخاب کن  ستیل  ک یرا از    موردنظر نام    دهد ی که به شما امکان م
 :د ی استفاده کن  ر یز يهاک یاز تکن کینام در آنجا ظاهر شود، از هر  د یخواهی که م د ید یرس   يابه نقطه  ی و وقت  د یآغاز کن

 . شودیکه ظاهر م  ی ستیو سپس انتخاب نام از ل Formulas > Use in Formula نهیگز انتخاب

  ي هاکه با نام  ی زمان  ژه یوبه   د، یها وارد کنرا در فرمول   يابازه   يها و بدون دغدغه نام   یراحتبه تا    کند ی روش کمک م   نیا
  .د یدار  سروکار ده یچیپ ای یطولان

 

  . د یمورد نظر خود را انتخاب کن  ياو سپس نام بازه  د یرا باز کن Use in Formula یینوار کشو  :5- 1 شکل

ها نام  يادآوریبه    ازین  نکه یبدون ا  د یها اضافه کنرا به فرمول   يابازه   يهانام  یراحتبه تا    دهد ی روش به شما امکان م  نیا
 .د یداشته باش 
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 نهیگز انتخاب Formulas > Use in Formula > Paste Names )د یکل ای F3ي وگو) تا کادر گفت Paste Name 
 . د یرا انتخاب کن OKو سپس  د یرا انتخاب کن   د یاستفاده کن د یخواهی که م  ياداده شود، نام بازه  شینما

 که با آن حروف    یها و توابعاز نام  ی ستیتا ل  د یکن پیرا تا يادو حرف از نام بازه  ایحروف اول  د یتوانی م نیهمچن
 .د یرا فشار ده Tabرا انتخاب کرده و  موردنظرداده شود، سپس نام  شینما شوند ی شروع م

  . د یخود وارد کن يهارا در فرمول  يابازه يهانام  یراحتبه تا  کند ی ها به شما کمک مروش  نیا

 هاها به فرمول اعمال نام

  ي هاخودکار نام  به طوراکسل    د،یاکرده  يگذارنامها را  و بعداً آن بازه  د یاخود استفاده کرده   يها ها در فرمول اگر شما از بازه
از اکسل   د یتوانی م  د،یکن  نیگزیجا  ی صورت دستمناسب را به   يها نام   نکه یا  يجابه ها اعمال نخواهد کرد.  را به فرمول   د یجد 

موجود خود    يهاها را به فرمول بازه  د یجد   يهاتا نام   د یدنبال کنرا    ریشما انجام دهد. مراحل ز  يکار را برا  نیا  د یبخواه
 :د یاعمال کن

ها را به  نام  د یخواهی اگر م  د یسلول واحد را انتخاب کن  کی  ای  د ی ها را به آن اعمال کننام  د یخواهی که م  يابازه   انتخاب  -  1
 . د ی) اعمال کنWorksheet( ي کل برگه کار

  شیرا نما  Apply Names  يوگو . اکسل کادر گفتFormulas > Define Name > Apply Names  نه یگز  انتخاب  -  2
 ). 6- 1(شکل  دهد ی م

 . د یاعمال شوند را انتخاب کن ست یل نیاز ا د یخواهی که م ییهانام  ا ی، نام Apply Names ستیل  در -  3

 .د یریبگ  دهیها نادو مطلق را هنگام اعمال نام   یتا ارجاعات نسب Ignore Relative/Absoluteکادر   انتخاب -  4

  . د یخود اضافه کن يهارا به فرمول  د یجد  يهانام  یراحتبه تا  کند ی مراحل به شما کمک م نیا
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  د،یفرمول خود اعمال کن يهابه بازه  د یخواهی که م  ییهاانتخاب نام ي برا Apply Names يوگو از کادر گفت  6- 1شکل 

  . د یاستفاده کن

هنگام   يبرگه کار  یو ستون  فیرد  يهااز نام   ایآ  د ییتا به اکسل بگو  Use Row And Column Namesانتخاب کادر    -  5
انتخاب کن  نی. اگر اریخ  ایها استفاده کند  اعمال نام انتخاب کن  Optionsدکمه    د یتوانی م  نیهمچن  د،یکادر را  تا   د ی را 

  ن یها» در او ستون هنگام اعمال نام   ف یرد  يها«استفاده از نام   بخش به    شتر یب  ات یجزئ  ي. (براد ینیبب  ي شتر یب  يهانه یگز
 .) د یفصل مراجعه کن

  .د یها را اعمال کنتا نام   OK انتخاب -  6

 هاو مطلق هنگام اعمال نام یارجاعات نسب گرفتنده یناد

  یاکسل تنها ارجاعات نسب د،یکن  رفعالیغ Apply Names ي وگورا در کادر گفت  Ignore Relative/Absolute نه یگز  اگر
که به ارجاعات   ییهاو ارجاعات مطلق را فقط با نام   کند ی م  نیگزیجا  شوند ی مربوط م  یکه به ارجاعات نسب  ییهارا با نام 

ها به فرمول  و مطلق را هنگام اعمال نام  ی ارجاع نسب  يهالب اکسل قا  د،یرا فعال بگذار  نهیگز  نی . اگر اشوند ی مطلق مربوط م
 . ردیگی م دهیناد

اشاره دارد.    A$1:$A$10$که به   Salesبه نام    ياو بازه  د یدار   SUM(A1:A10)مانند =  ی فرمول  د ی، فرض کنمثالعنوانبه 
 Sales  رایرا به بازه در فرمول اعمال نخواهد کرد؛ ز  Salesباشد، اکسل نام    رفعالیغ  Ignore Relative/Absolute  نهیاگر گز

 است.   یبازه نسب  ک ی شاملبازه مطلق اشاره دارد و فرمول  ک یبه 
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را   Ignore Relative/Absolute  نهیکرد، بهتر است گز  د یخواه  جاجابهرا    تانیهافرمول   د یفکر کن   نکهیمگر ا  ،یطورکلبه 
  .د یفعال بگذار

 هاو ستون هنگام اعمال نام فیرد يهااستفاده از نام 

 Apply Names  يوگو را در کادر گفت   Use Row And Column Namesخود، کادر    يهادر فرمول   شتر یوضوح ب  يبرا
  يگذارنام   ف یرد  ک ی تقاطع    عنوانبه   توانند ی را که م   ی که تمام ارجاعات سلول  د یگوی به اکسل م  نه یگز  ن ی. اد یفعال بگذار

 نام دهد.   رییشوند، تغ ف یشده توص  يگذارستون نام  کی شده و 

  نیبه ا  نیشده است. ا  يگذارنام  Rentبه نام    C7:E7و بازه    Januaryبه نام    C6:C10، بازه  7- 1، در شکل  مثالعنوانبه 
 ارجاع داده شود.  January Rentبه عنوان  تواند می —دو بازه  ن ای تقاطع—C7است که سلول   یمعن

) در حال حاضر شامل F6(سلول    Advertising  فیرد  يبرا  Totalنشان داده شده است،    7- 1شکل    که در   طورهمان
 Use Row And Column  نهیاعمال کرده و گز  يبرگه کار  نیها را به ابازه  يهااست. اگر شما نام  =C6 + D6 + E6فرمول  

Names ابد ی ر ییتغ  ریفرمول به شکل ز ن یا رودی انتظار م د، یرا انتخاب کن: 

=January Advertising + February Advertising + March Advertising 

 
  شامل فرمول  F6 (Total Advertising) ها اعمال شوند، سلولبازه به فرمول  يهانام  نکهیقبل از ا 7 - 1شکل 

 =C6 + D6 + E6  است.  

  . د یکنی ممشاهده    8- 1که در شکل    گونهآن   .د یآوری به دست م   ی متفاوت   یفرمول کم  د،یکار را امتحان کن  نی، اگر احالنیباا
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  است. January + February + Marchفرمول = يحاو  Total Advertisingبازه، سلول  يهاپس از اعمال نام  8- 1شکل 

  ن ی. (همچنردیگی م  ده یباشد ناد  فی فرمول در همان رد  که ی درصورترا    ف ینام رد  کند، ی ها را اعمال ماکسل نام   ی چرا که وقت
را در    Advertising، اکسل نام  F6، در سلول  مثالعنوان به .)  ردیگی م  دهینام ستون را اگر فرمول در همان ستون باشد ناد

  قرار دارد.   Advertising ف یرد  در F6 رایز رد یگی م ده یهر عبارت ناد

  

  

  

  

  یی باشد، جا  کنندهج یگ  تواند ی بزرگ م   ي برگه کار  ک یاما در    ست،یساز نمدل کوچک مشکل   کی در    ف یرد  يهاحذف عنوان 
  د، یکنی بزرگ اعمال م  يبرگه کار  ک یها را به  نام   د یاگر دار  ،نی ؛ بنابراد ینیرا بب  هاف یرد  يهانام   د یکه ممکن است نتوان

 . د یشامل کن زیرا ن  ف یرد يهانام ها،هنگام اعمال نام  د یدهی م حیاحتمالاً ترج

که در    دهد ی م   شیرا نما  ياافته یگسترش   يوگو ، کادر گفت Apply Names  يوگو در کادر گفت   Optionsدکمه    انتخاب
) را  فیستون (و رد   نیعناو  دهد ی است که به شما امکان م  یاضاف  يهانه ی شامل گز  نینشان داده شده است. ا  9- 1شکل  

 :د یشامل کن


  هیداد، بلکه بق رییرا تغ  F6فرمول موجود در سلول  تنهانهها که اعمال نام دی داشته باشتوجه  :نکته ࢘ࢗ࢖࢕࢔
  هیآرا کیکل ستون   ياست که اکسل برا لی دل نیاتفاق به ا نی پر کرد. ا زیرا ن  Totalها در ستون فرمول

 يهافرمول  جادیا"، 2به فصل   ک، ی نامید يهاهی درباره آرا شتریب يریادگی  يکرد. برا جادیا  کینامید
  . دی، مراجعه کن"شرفتهیپ
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 Omit Column Name If Same Column :ها ستون را هنگام اعمال نام  يهاتا نام  د یکن  یکادر را خال نیا
 .د یشامل کن

 Omit Row Name If Same Row :د یرا شامل کن فیرد يهاتا نام  د یکن  یکادر را خال  نیا . 
 Name Order: هانه یگز نیاز ا )Row Column ای Column Rowها در ارجاع  نام بی انتخاب ترت ي ) برا

  . د یاستفاده کن

  
  Apply Names افتهیگسترش   يوگو کادر گفت   9- 1شکل 

 هافرمول يگذارنام

که به    ستین  ي ازیفرمول ن  نی. اد ی کن   ف یتعر  شوند ی که به طور مکرر استفاده م  ییهافرمول   يبرا   ییهانام   د یتوانیم  شما
تر  شما را آسان  ي کار   يهابرگه بلکه معمولاً    کند؛ی م  ره یحافظه را ذخ  تنهانه کار    ن یسلول ظاهر شود. ا  ک یدر    ی کیزیطور ف

 : د یفرمول دنبال کن ک ی يگذارنام  ي را برا ر ی. مراحل زد یتا بخوان کند ی م

 داده شود.  شینما New Name يوگوتا کادر گفت Formulas > Define Name انتخاب -  1

 .Nameدر کادر  د یفرمول استفاده کن  يبرا د یخواهی که م ی کردن نام  وارد -  2
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 .د یوارد کن  د،یکنی وارد م يبرگه کار  کیکه آن را در    یمانند زمان قاًی ، فرمول را دقRefers Toکادر    در -  3

 . OK انتخاب -  4

 

 خود فرمول).   يجابه ( د یخود وارد کن  ي برگه کار يهانام فرمول را در سلول  د یتوانی م  اکنون

 است: ر یز صورتبه شعاع کره است)  rکره (که  کی ، فرمول حجم  مثالعنوانبه 

4πr3/3   

کن  ن،یبنابرا شما    د یفرض  نام    کیکه  با  جا  Radiusسلول  دار  ییدر  کاربرگ  مثلاً    یفرمول   د یتوانی م  د،ی از  نام،  به 
SphereVolume  را در کادر    ر یز  ي ورود  د یتوانی . سپس مد یکن  جادیاRefers To  ي وگوکادر گفت  New Name  دیقرار ده 

 ): گرداند ی را برم یاست که مقدار پ یتابع PI(که در آن 

=4 * PI() * Radius ^ 3 / 3 

  

 هادر فرمول  وندهایکار با پ

  ن یا نی ب ي وند یپ د یتوانی م د، یاستفاده کن گر یکاربرگ د ک یها در  از آن  د یخواهی که م  د یکاربرگ دار  ک یدر  ییهاداده   اگر
  گر یها در کاربرگ دبازه  ایها  که به ارجاعات به سلول  دهد ی شما اجازه م  يهاکار به فرمول   نی. اد یکن  جاد یدو کاربرگ ا

 .کند ی م  یروزرسانرا به  وند یاکسل به طور خودکار پ کنند،ی م  ریی تغ گر ید يها که داده  یاشاره کنند. زمان

شامل   Chapter01در کاربرگ    Budget Summary  تیاست. ش   يوند یدهنده دو کاربرگ پنشان  10-1، شکل  مثالعنوانبه 
 ت یدر ش   B2سلول  يطور خاص، فرمول نشان داده شده برا است. به  Chapter01aدر کاربرگ  Details تیاز ش  ییهاداده 

Budget Summary    به سلول    یارجاع خارج  کی شاملR7   تیدر ش  Details    است. اگر مقدار درR7  کند، اکسل    ر ییتغ
  .کند ی م یروزرسانرا به  Chapter01بلافاصله کاربرگ 

  

  

  

  


 ی. کاربرگشودیم  ده ینام  )ي(کاربرگ مشتر  است کاربرگ وابسته  یکه شامل ارجاع خارج   یکاربرگ :نکته  ࢘ࢗ࢖࢕࢔
  . شودی م ده ینام (کاربرگ سرور) است کاربرگ منبع یاصل يهاکه شامل داده 
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در   R7به سلول  Chapter01از کاربرگ   B2فرمول در سلول   رایاند زخورده  وند یدو کاربرگ به هم پ  نیا 10- 1شکل 

  اشاره دارد.  Chapter01aکاربرگ  

 ی درك ارجاعات خارج

  ک یبازه در  ایسلول  ک یبه  یارجاع خارج کی وجود ندارد. شما با درج   یارجاع خارج يهانکیدر پشت ل یراز بزرگ  چیه
در مثال    یارجاع خارج  آوردن دستبه   ي . براد یکنی م   م یرا تنظ  هانک یل  از همان کاربرگ)   گرید   ت یش   کی (در    گر یکاربرگ د

وارد کردم و سپس سلول    Budget Summary  ت یاز ش   B2(=) را در سلول    ر ، من علامت براب10- 1در شکل    شدهداده نشان
R7  ت یرا در ش Details  .انتخاب کردم 

 است: ریز صورتبه آن  نتکسیس  نجای . اد یراحت باش  یارجاع خارج کیبا ساختار  د یفقط با شما

'path [workbookname] sheetname'! reference 
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path :ي اریکاربرگ (اخت  رهیمحل ذخ ریمس ( 

workbookname: نام کاربرگ 

sheetname:  تینام ش 

reference:  بازه دلخواه  ای ارجاع به سلول 

 

  ها مراجعه کند.گرفتن داده   يبرا صفحه اکسلو  فایل که به کدام  د یگوی ساختار به اکسل م نیا

  
  10- 1در شکل    شدهداده ش ینما  یاکسل به طور خودکار ارجاع خارج  د،یرا ببند   Chapter01a، اگر کاربرگ  مثالعنوانبه 

 ):ل یفا ی واقع  ری(بسته به مس دهد ی م  رییتغ  ریرا به صورت ز

=' C:\Users\Paul\Documents\ [Chapter01a.xlsx] Details'! $R$7 

 ارجاع: نیا در

C:\Users\Paul\Documentsکاربرگ لیفا ری: مس 

]Chapter01a.xlsxنام کاربرگ :[ 

Detailsتی: نام ش 

 !$R$7 ارجاع به سلول :R7 تیدر ش Details 

  اگر کاربرگ منبع بسته باشد.  ینسبت دارند، حت فایل و صفحهبه کدام  همچنانها که داده  دهد ی به اکسل اطلاع م نیا
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 وندها ی پ یروزرسان به

شما   از یموردنکاربرگ اطلاعات    کی است. اگر    تیش   نیها در چند ها و داده اجتناب از تکرار فرمول   وند، یپ  کی  جادیاز ا  هدف
 .د یاستفاده کن گر یآن در کاربرگ د د یبه بازتول  از یها بدون نارجاع به آن داده  ي برا يوند یاز پ د یتوانی را شامل شود، م

آنچه در کاربرگ منبع وجود دارد، باشند.   کنندهمنعکس همواره    د یها در کاربرگ وابسته با، داده دبودن یمف ي ، براحالنیباا
 داده شده است: حیتوض  ری ز صورتکه به   د یحاصل کن نان یموضوع اطم ن یاز ا وند،یپ یروزرسانبا به  د یتوانی م

 ر ییمنبع تغ ل یها در فارا هر بار که داده  وند یخودکار پ به طور هر دو کاربرگ منبع و وابسته باز باشند، اکسل  اگر  
 .کند ی م  یروزرسانبه  کنند،ی م

 را   وندهایخودکار پ به طور کاربرگ منبع در زمان باز کردن کاربرگ وابسته باز باشد، اکسل دوباره  اگر
 .کند ی م یروزرسانبه 

 شیدر نوار اطلاعات نما ی تیهشدار امن ک یکاربرگ منبع بسته باشد هنگام باز کردن کاربرگ وابسته، اکسل  اگر  
 Enable نه ی صورت، گز ن یشده است. در ا رفعالیغ  وندهایخودکار پ یروزرسانبه  د یگوی که به شما م دهد ی م

Content د یرا انتخاب کن . 

  

  

  

  

  

 

  


که  دیدار  ازین  یفقط در صورت  تینام کاربرگ و نام ش  ر، ی ) در اطراف مس''تک (  يهاشما به نشانه :نکته  ࢘ࢗ࢖࢕࢔
باشد   نام مس  ایکاربرگ بسته  ا  یخال  يشامل فضاها  تیش  ایکاربرگ    ر، یاگر  اگر در  مورد شک   نیباشد. 

اگر که   ردیگیم  ده یدها را ناآن   یراحتبه اکسل    د؛یتک را شامل کن  يهانشانه  هرحالبهبهتر است    د، یدار
  لازم نباشند. 


هم :نکته  ࢘ࢗ࢖࢕࢔ شما  پ  شهیاگر  کاربرگ  يوندهایبه  در  دار  يهاموجود  اعتماد  با    ، یعنی(  دیخود  هرگز  اگر 
)،  د یندار  سروکار  د، یها اعتماد ندارکه به طور کامل به آن   یاز منابع   ییهاکاربرگ  ای شخص ثالث    يهاکاربرگ

شروع، مراحل   يبراکند.    ین روزرسارا به   وندهای پ  شهیتا به طور خودکار هم   دیکن  میاکسل را تنظ   دیتوانیم
 :دیرا دنبال کن  ریز

 . File > Options > Trust Center > Trust Center Settings انتخاب

 . دیرا انتخاب کن Trust Center ،External Content يوگو کادر گفت در

 . دیرا انتخاب کن Enable Automatic Update For All Workbook Links نهیگز سپس

 .OKو سپس دوباره انتخاب  OK انتخاب

  خواهد کرد.  یروزرسان را به  وندهای اکسل به طور خودکار پ مات، یتنظ   نیا با
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 ی روزرسانآن را به   د یهر زمان که بخواه  د یتوانی م  د،ینکرد  یروزرسانرا به   وند یپ  د یکه سند وابسته را باز کرد  یاگر شما زمان
مراجعه    11- 1(به شکل    شودی داده م  شیکه نما  Edit Links  ي وگو. در کادر گفت Data > Edit Linksبا انتخاب    د یکن
  .د ی را انتخاب کن Update Values نه یمورد نظر را انتخاب کرده و سپس گز وند ی)، پد یکن

  
  .د یدر کاربرگ منبع استفاده کن   يوند یپ يهاداده  یروزرسانبه  ي برا Edit Links يوگو از کادر گفت  11- 1شکل 

 وند یمنبع پ  ریی تغ

  ماًیمستق  د یتوانی بمانند. م  یروز باقها به تا داده   د یکن  شیرایرا و  وند یکه پ  د یدار  ازیکند، شما ن  ریینام سند منبع تغ  اگر
 :د ی ده ر ییتغ ر یمراحل ز کردندنبالمنبع را با  د یتوانی م ای د ی کن ش یرایرا و یارجاع خارج

 داده شود.  شینما  Edit Links  يوگو تا کادر گفت   د یرا انتخاب کن  Data > Edit Linksفعال بودن کاربرگ وابسته،    با  -  1

 .د ی انتخاب کن د،یبا آن کار کن د یخواهی را که م ي وند یپ -  2

 .دهد ی م شیرا نما Change Source ي وگو. اکسل کادر گفتد یرا انتخاب کن  Change Source نه یگز -  3

 Edit  يوگو بازگشت به کادر گفت   يرا برا  OKو پس از آن    د یکرده و سپس آن را انتخاب کن  دایرا پ  د یمنبع جد   سند   -   4

Links د یانتخاب کن.  

  .د یتا به کاربرگ بازگرد د یرا انتخاب کن Closeگزینه   –  5

 


